
Helpinator

Version 3.23

User Manual

Copyright © 2020 Major Mind Software



Table of Contents

About ............................................................................................................................................... 5
Benefits ........................................................................................................................................... 6
Tutorial ............................................................................................................................................. 7
    Starting a new project .................................................................................................................. 8
    Capturing screenshots ............................................................................................................... 11
    Adding callouts ........................................................................................................................... 17
    Writing topics ............................................................................................................................. 19
    Creating a tutorial (a step-by step guide .................................................................................... 26
    Compiling a help file ................................................................................................................... 36
Support ......................................................................................................................................... 40
Order ............................................................................................................................................. 41
How to... ........................................................................................................................................ 42
    Start a new project ..................................................................................................................... 42
    Import existing documentation ................................................................................................... 46
    Capture screenshots ................................................................................................................. 52
    REcapture screenshots ............................................................................................................. 54
    Add annotations to screenshots ................................................................................................ 55
    Quickly update screenshots when UI changes ......................................................................... 56
    Create step-by-step guides ........................................................................................................ 56
    Create CHM help file .................................................................................................................. 62
    Create PDF and printed manuals .............................................................................................. 64
    Create WebHelp ......................................................................................................................... 67
    Create QtHelp ............................................................................................................................ 69
    Create JavaHelp and OracleHelp ............................................................................................... 73
    Create EPUB and MOBI ebooks ................................................................................................ 73
    Embed Video from YouTube, Vimeo and etc ............................................................................. 77
    Change order and hierarchy of topics quickly ............................................................................ 80
    Create a FAQ ............................................................................................................................. 82
    Create a Quiz ............................................................................................................................. 85
Getting Started ............................................................................................................................. 89
    UI Overview ................................................................................................................................ 89
    Project Structure ........................................................................................................................ 89
    Output Formats .......................................................................................................................... 90
Project ........................................................................................................................................... 91
    Variables ..................................................................................................................................... 93
    Storage Modes ........................................................................................................................... 93
Topics and Content ...................................................................................................................... 95
    Manage Topics ........................................................................................................................... 95
    Classic Toolbar WYSIWYG Editor ............................................................................................. 96
    Tabbed Toolbar Editor ................................................................................................................. 99
Styles .......................................................................................................................................... 102
    Text and Paragraph Styles ....................................................................................................... 102
    Table Styles .............................................................................................................................. 104
    Shape Styles ............................................................................................................................ 105
    Guide Styles ............................................................................................................................. 107
Manage Glossary ....................................................................................................................... 111
Images ........................................................................................................................................ 113
    Managing Images ..................................................................................................................... 113
    Image Editor ............................................................................................................................. 115
    Using Images ............................................................................................................................ 117
    Cloned Images ......................................................................................................................... 119

Helpinator 3.23 Manual

2



    Paste from Clipboard ............................................................................................................... 123
How to Work With Video .......................................................................................................... 125
Step-by-step Guides ................................................................................................................. 130
    How to create a step-by-step guide ......................................................................................... 130
    How to use guides in topics ..................................................................................................... 136
Text Snippets .............................................................................................................................. 137
    How to use text snippets .......................................................................................................... 138
Code Snippets ........................................................................................................................... 141
    How to use code snippets ........................................................................................................ 142
    Code snippets in help files ....................................................................................................... 143
Templates ................................................................................................................................... 146
    HTML-based Templates ........................................................................................................... 147
    PDF/RTF/Print Templates ........................................................................................................ 150
Tools ............................................................................................................................................ 154
    Search and Replace ................................................................................................................ 154
    Context IDs ............................................................................................................................... 155
    Screenshots ............................................................................................................................. 156
    Global Spellcheck ..................................................................................................................... 159
    Image Tools .............................................................................................................................. 160
    Check Links .............................................................................................................................. 161
    REImport .................................................................................................................................. 162
    WordPress Theme Builder ...................................................................................................... 163
    GIF Screen Recorder ............................................................................................................... 165
Reports ....................................................................................................................................... 167
ToDo List .................................................................................................................................... 169
Formats ...................................................................................................................................... 171
    CHM .......................................................................................................................................... 172
    PDF/RTF .................................................................................................................................. 175
    Classic WebHelp ..................................................................................................................... 179
        Analytics and Social Integration ................................................................................................. 182
        Adapt to your website ............................................................................................................... 183
        How to Change Style of the Left Pane ........................................................................................ 184
    WebHelp - JqueryUI ................................................................................................................. 185
    Printed Manuals ........................................................................................................................ 185
    QtHelp ...................................................................................................................................... 186
    JavaHelp ................................................................................................................................... 190
    EPUB ........................................................................................................................................ 194
    MOBI ......................................................................................................................................... 195
    OracleHelp ............................................................................................................................... 198
    HelpGUI .................................................................................................................................... 200
    MajorMindHelp .......................................................................................................................... 201
    Wordpress CMS ...................................................................................................................... 202
    Knowledge Base ...................................................................................................................... 204
        Understanding Profiles .............................................................................................................. 205
    GitHub-flavored Markdown ....................................................................................................... 210
    SimpleDocServer ..................................................................................................................... 212
    LiteHelp ..................................................................................................................................... 212
    LeanPub ................................................................................................................................... 213
    ReadTheDocs .......................................................................................................................... 215
    WebHelp - Bootstrap ................................................................................................................ 215
Advanced Topics ....................................................................................................................... 216
    Conditional compilation ............................................................................................................ 216
    Command line tool ................................................................................................................... 216
    Organizing text reviews ............................................................................................................ 217
    Batch Compile .......................................................................................................................... 217

Helpinator 3.23 Manual

3



    MajorMindHelpViewer ............................................................................................................... 219
Localizing help files ................................................................................................................... 220
    Multiple languages .................................................................................................................... 220
    Language strings ...................................................................................................................... 220
    XML Import/Export .................................................................................................................... 221
Quizzes ....................................................................................................................................... 222
    Quizzes Editor Overview ......................................................................................................... 222
    How to Embed a Quiz .............................................................................................................. 225
    Sample Quiz ............................................................................................................................ 225
FAQ Lists .................................................................................................................................... 227
    FAQ Editor Overview ................................................................................................................ 227
    How to Embed a FAQ .............................................................................................................. 230
    Sample FAQ ............................................................................................................................. 230
Quiz Answers ............................................................................................................................. 231
Glossary ......................................................................................................................................... -1
Index ............................................................................................................................................... -1

Helpinator 3.23 Manual

4



About

Helpinator is an integrated documentation development environment with accent on productivity.

Helpinator is a single source tool. You can compile CHM, PDF, RTF, DOCX, WebHelp (Classic and New
WebHelp2), Knowledge Bases, Mobile, GitHub-flavored Markdown, Printed Manuals, EPUB and
MOBI ebooks, JavaHelp, OracleHelp, HelpGUI, LeanPub, DocBook, DITA, ASCIIDoc,
reStructuredText, MajorMindHelp, LiteHelp and plaintext readme all from single source. You can even
create software documentation WordPress themes and publish your online documentation to WordPress!
Helpinator is a WYSIWYG tool. Write content in a friendly environment.
Helpinator is multilingual. You can have as many project languages as you wish. Work with any translation
service you wish using "XML Import/Export."
Helpinator has a set of unique features like embeddable step-by-step guides, FAQs and self-checkup
quizzes.

Major Mind Software provides MajorMindHelpViewer and LiteHelpViewer free of charge if your content was
generated using Helpinator. 

There's a features tour on our website: 

https://www.helpinator.com/helpinator.html
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Benefits

Check out the complete list of benefits here:
  
https://www.helpinator.com/benefits.html
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Tutorial

This tutorial will show you how to create a simple help file for your application using Helpinator Help Authoring
Tool. It covers basic steps without drilling deep into advanced features, so you will get a clear understanding
of what Helpinator is about without unnecessary information.

In this tutorial we'll create a help file for another our product called "MiniKanban": 

MiniKanban tool
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Starting a new project

When you run Helpinator you see "Welcome" screen with links to documentation, blog and most common
actions. Click on the "New Project" link. 

New project

"New project" dialog appears. 
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New project - General tab

Enter project title here. If you plan to create multi-lingual project, it's a good time to click "Add languages"
and select additional languages for this project.
Now select "Topics and keywords" tab. Enter topic titles and basic keywords. Don't worry if you can't think of
any right now - you'll be able to add them at any time. 
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New project - topics and keywords

On "Templates" tabs you can select predefined templates for different types of documentation. For now we'll
leave default settings there.
When everything is ready click "OK". Helpinator opens up newly created project.
Now let's select "Variables" tab and enter your product's and company name, version and year of the release.
The first step is done. 

Helpinator 3.23 Manual

10



Project variables

Capturing screenshots

Helpinator allows you to capture screenshots and automatically create topics with captured screenshots.
Helpinator stores screenshots to the project's image library where you can manage/edit/update imges easily.
First select "Screenshots" node in the project tree view. 
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Screenshots - General tab

Helpinator 3.23 Manual

12



Screenshots - Create topics and guides.
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Screenshots - Select what to capture.

Make required settings as shown above and click "Start". Now when you press hotkey combination
Helpinator captures active window and stores it to the image library. We'll capture screenshots of main form,
progress form and log.
Let's check created topics: 

Helpinator 3.23 Manual

14



Topics created by screenshot tool

Newly added topics have the name of the captured window as a title, and a reference to the captured image
stored in the image library.
Now, let's reorder created topics and and move them under "UI" node. Just drag and drop them to the "UI"
node, then rearrange using "up" and "down" arrows on the toolbar. 
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Rearrange topics

Let's take a look at the library. Captured images are now there under "ui" category. 
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Image library

Adding callouts

Now let's add some callouts to the screenshots. Select an image to work on take a look at shapes toolbar.
Select shape style (we use "Red and Yellow" here). Click on rectangle shape on the toolbar and draw it where
you want callout to appear. Now select "Arrow" shape and connect rectangle with a target element, in our
case the toolbar buttons. Double click the rectangle and enter text into "Caption" field. 
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Activate editor
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Add caption

Writing topics

Now let's write some introductory text. 
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Topic editor.

Suppose our users live in a perfect world of sunshine and rainbows and never knew anything about satan. We
need to explain this term. And again Helpinator is here to save you, it has built-in Glossary manager. 
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Glossary

In the "Add Glossary Terms" dialog click on "Import k/w", this will import project's keywords into glossary. 
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Add glossary terms.

Now you can write definitions for the terms added. 

Write glossary term definition.

Let's go back to the topic editor and create a hyperlink for the glossary term. 
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Inerting a hyperlink

In the "Insert hyperlink" dialog select the term to link to. 
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Insert hyperlink.
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After hyperlink was inserted

Return to the topic editor. Now let's insert a "Warning" aside using the toolbar button. Later we will see how it
will be rendered in the output. 
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Insert aside

Creating a tutorial (a step-by step guide

Helpinator has built-in tutorial maker, that allows you to make tutorials from images in the project image
library.

First off we need to prepare images for our tutorial. We already captured all application dialogs but added
callouts to them that describe UI elements, not the tasks we need to document. So we'll use another
Helpinator's unique feature and create "cloned" images from the images already in the library. This will allow
us to add callouts exactly for our tutorial.

We are about to create a step-by-step guide that shows how to add a new task to the board.

For this purpose we will add several clones of the image that contains screenshot of "Add a task" dialog. This
dialog has a number of edits and switches, so we will have to split the explanation into several steps.
However it's impractical to use different images with the same screenshot. And it's hard to maintain.
Helpinator allows to create "cloned" images of the same donor, so there's no need to manage more than one
copy and we will need to update just one image when the dialog changes. 
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Manage images add clone

"New cloned image" dialog allows to add several clones of a donor image at once and store them to selected
category. 

New cloned images
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Now we can add callouts to the images of our tutorial on every step. 

Add callouts.
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Callouts for attachments.
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Callouts for checklists.

Now we can go and create a tutorial itself. 
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Manage guides
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Add guide dialog

Step images

By default tutorial steps have the same names as the images selected. We need to rename them and place
in correct order. 
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Rename and reorder steps.

Now you can write step text into the field below the step image.
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Write step text

After all step texts are ready we can insert a placeholder for our tutorial into a corresponding topic. Topic
named "Tutorial" in our case.
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Insert guide using a toolbar
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Guide in topic editor

Compiling a help file

OK, here we go. Everything is ready and we can now see our help file in all it's glory. We are going to compile
a LiteHelp help file at this step. LiteHelp is a lightweight portable help system for desktop Windows apps
created by Major Mind Software as a replacement for CHM (HTML Help).
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Compile LiteHelp

Below is the "Warning" aside, rendered with exclamation icon and yellow background.

"Warning" aside in LiteHelp.
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Our step-by-step guide as a slideshow with navigation.

Step-by-step guide in LiteHelp
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Glossary in LiteHelp
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Support

Registered users of Helpinator - please submit your requests to the support helpdesk:

http://www.majormind.com/helpdesk
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Order

Check this page for purchase info:

http://www.helpinator.com/order.html

Note that licenses in packs are cheaper than individual licenses.

You will receive your activation key within minutes. In case the key didn't arrive on time:
1. Check out "Spam" folder
2. Contact support with your Order ID.
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How to...

This sections contains quick guides on how to perform most common help authoring tasks.

Start a new project

 
1. Click "New project"
 

 
Click "New project" on the toolbar on in the welcome screen
 
2. Adjust General Settings
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At this step you can select project default language and additional languages. You can also select storage
mode and path to save your new project to.
 
3. Add Topics and Keywords
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Here you can add some topics and keywords to start new project with. Use TABs for new levels.
 
4. Add Images
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If you already have some captured screenshots you can add them to your project at this step. Click "Add
Images" and select image files. You can also check "Add topics" to add new topics for each of the added
images.
 
5. Select Templates
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Select templates for all supported formats. You can select from built-in templates or choose your own
template stored outside of Helpinator installation.
 

Import existing documentation

 
1. Run "Convert to Helpinator 3 Project"
 

 
 
2. Select source type
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First of all, select what you want to import.
 
3. Select source files
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Select source files (in case of old Helpinator project or CHM) OR source folder (in case of HHP and
DOC/TXT/HTML files import).
 
4. Select destination project storage mode
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Select destination project storage mode. Single file mode is more compact while "Multiple files" mode is good
for version control systems - you can check in only those files that were altered, not entire project.
 
5. Enter destination path
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Select path to save new project with imported data to.
 
6. Select default project language
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Select default destination project file. You can add more languages later.
 
7. Click "Run"
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Clcick "Run" and wait for the process to finish. Now you can open destination file in Helpinator.
 

Note that import creates topics tree according to the order of file names, you'll have to set the proper order of
topics by yourself. Read this topic to know how to do it quickly.

Capture screenshots

 
1. Select "Screenshots" node
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2. Set up general options
 

 
Select wether you want to capture new image or REcapture (update) existing one. You can also specify image
name mask, category to store it to and image format.
 
3. Create topics and guides
 

 
Check whether you want to create a new topic for captured image, append it to an existing topic, create new
step-by-step guide or append to existing guide.
 
4. Additional capture options
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You can select to capture only active window, entire desktop, area around mouse cursor, capture mouse
pointer and background around capture window with effects.
 

REcapture screenshots

If you store all your screenshots in the image library of your project you can easily recapture screenshots.
This saves you a lot of time because you don't need to capture screenshots, find topics that you need to
update and insert new images instead of old ones. With Helpinator you only need to select "REcapture"
mode in the screenshot tool and select image from the library to recapture. Note that callouts remain the
same, only image itself changes.
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Recapture a Screenshot

Add annotations to screenshots

You can add callouts and annotations to the images stored in the image library. Select an image and click
"Tools->Activate shape editor".

Activate Shape Editor
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Then select color style from "Style" selector and add any shape, arrow or callout you like.

Add callouts

Quickly update screenshots when UI changes

Helpinator has three main features that help you to update screenshots quickly:

1. Image Library. When you store all screenshots in the image library you don't need to browse through all
topics to find screenshots that you need to alter.

2. Screeshot REcapture. This feature allows you to REcapture screenshots that are stored in the image
library. Image name remains the same as well as added callouts/annotations.

3. "Cloned" Images. Clones share the same image with "donor" but each has it's own callouts/annotations.
When UI changes you only need to update "donor" images and Helpinator updates clones automatically.

Create step-by-step guides

 
1. Prepare images
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Prepare images for your guide. You can add existing images to the image library, capture some screenshots
or create cloned images. Add callouts using image editor to emphasize meaning of the corresponding step.
 
2. Select guides node
 

 
Select "Step-by-step Guides" node in the project tree view.
 
3. Click "Add Guide"
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Click "Add Guide". New guide dialog box appears.
 
4. Name your guide
 

 
Give appropriate name to your guide. It is recommended to avoid use of spaces and special characters since
this name will be used in "SBS" placeholder.
 
5. Create topic
 

 
Check "Add topic" to automatically add topic with created guide. It will be added as the last topic in the
project. You can use project tree drag and drop feature to put it in the correct place. 
If you leave it unchecked then you need to manually insert "SBS" placeholder into desired topic.
 
6. Add images
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Click "Add images" button to add images for steps. You will be able to rearrange and rename steps later.
 
7. Select images to add to the guide
 

 
Select images for steps. Images are taken from the project's image library. Check as many images as you
wish.
 
8. List of steps
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The list of steps is at the left top corner of the guide editor. On top of the list there are tool buttons to edit it.
 
9. Give short names to each step
 

 
Click "Rename" to give appropriate titles for steps. 
 
10. Put steps in the correct order
 

 
Reorder steps using "Up" and "Down" buttons.
 
11. Add descriptive text for each step
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Write some descriptive text for each step. Be short, image should say for itself.
 
12. Set up guide options
 

 
Guide options are at the left bottom row. Here you can select whether you want to add step numbers to step
images, select color scheme to use for step numbers and where they should be located on the step image.
Check "Auto size" if you want Helpinator to select size of the HTML box automatically, or set width and height
manually.
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Create CHM help file

 
1. Install HTMLHELP.EXE
 

 
First of all you need HTMLHELP.EXE (a tool from Microsoft that allows you to compile CHM help files). For your
convinience it is packed in the same zip archive with Helpinator.
 
2. Check "HTML-based templates"
 

 
Check "HTML-based templates" node of the project tree view. It has default.html template for CHM output but
you can check for more built-in templates.
 
3. Click "+" to add more CHM templates
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Click on green plus sign and "Add template" dialog opens.
 
4. Select a template from the drop-down list
 

 
Select a template from the drop-down list. A preview od compiled topic appears at the bottom. Note that
there is "For: CHM" text below template title.
 
5. Select added template from the drop-down list
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Now you need to activate your template. Select root node in the project tree view, browse to "Templates" tab
and select template from the "CHM" drop-down.
 
6. Click "Compile CHM" on the main tool bar.
 

 
Now you can click "Compile CHM" on the main tool bar and Helpinator will compile a CHM help file for you.
 

Create PDF and printed manuals

 
1. Select "PDF/RTF/Print templates"
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First of all, let's check what template you can use for PDF output besides default template in your project.
 
2. Click "Add template"
 

 
Currently the list of templates cosists only of "default.rtf", click "+" sign to add more templates.
 
3. Select new template
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"Add template" dialog appears. Now you can select from "Built-in" drop-down list. Template preview at the
bottom updates automatically. Note "For: PDF" label below template name.
 
4. Set new templates for PDF and print
 

 
Select root node in the project tree view, then "Templates" tab and select new templates for PDF and PRINT.
However you can keep "default.rtf" template, if it's good enough for you.
 
5. Click "Compile PDF"
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Now you can click "Compile PDF" or "Print" buttons on the main tool bar to create a pdf file or send output to
printer.
 

Create WebHelp

 
1. Select "HTML-based templates"
 

 
 
2. Click "Add Template"
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3. Check for WebHelp templates
 

 
 
4. Set WebHelp template
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Select root node in the project tree view, then "Templates" tab and set WebHelp template (or leave
default.html there).
 
5. Click "Create WebHelp"
 

 
Click "Create WebHelp" button on the main tool bar.
 

Create QtHelp

 
1. Download and install Qt SDK
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Download and install QtHelp SDK if you haven't already done so.
 
2. Set path to qthelpgenerator.exe
 

 
Select Main Menu->Tools->Options and enter "Path to QtSDK BIN folder" where qthelpgenerator.exe is
located.
 
3. Select "HTML-based templates"
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Select "HTML-based templates" and check there's a template for QtHelp. Helpinator's default.html is QtHelp-
compatible.
 
4. Click "Add template"
 

 
Click "Add template" if you are not satisfied with default template.
 
5. Check for QtHelp templates
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Select templates that have "For: QTHELP" label.
 
6. Set QtHelp template
 

 
Select root node in the project tree view and browse to "Templates" tab, then select template for QtHelp from
the drop-down list or leave default.html.
 
7. Compile QtHelp
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Now you can click "Compile QtHelp" on the main tool bar to compile QtHelp help file.
 

Create JavaHelp and OracleHelp

The following topics cover in details how to compile:
JavaHelp
OracleHelp

Create EPUB and MOBI ebooks

 
1. Select "HTML-based templates"
 

 
Select "HTML-based templates" node in the project tree view and check for "epubmobi-default.html" template.
If it is in place, proceed to step 5.
 
2. Click "Add template"
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Click "+" to add epub-mobi template. IF you can see it in the list, you don't need to add it.
 
3. Select epub-mobi template
 

 
Select "epub-mobi" template from the list and click "OK"
 
4. Set epub-mobi template
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Select root node in the project tree view and browse to "Templates" tab, then select "epub-mobi" template
from drop-down lists for EPUB and MOBI formats.
 
5. Compile EPUB
 

 
Now you can click "Compile EPUB" to create epub file. To compile MOBI you need to take some more steps.
 
6. Download KindleGen
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To compile MOBI you need to download and install KindleGen - free command-line tool from Amazon that
allows to create MOBI ebooks.
 
7. Set path to KindleGen
 

 
Select Main Menu -> Tools -> Options and enter path to KindleGen utility.
 
8. Compile MOBI
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Now you can click "Compile MOBI" to create mobi file.
 

Embed Video from YouTube, Vimeo and etc

 
1. Get HTML Embed Code from service provider
 

 
First of all you need to get your video embed code from video service provider (YouTube in this case).
 
2. Select "Video" node
 

Helpinator 3.23 Manual

77



 
Select "Video" node in the project tree view.
 
3. Click "Add video from YouTube"
 

 
Click "Add video from YouTube, Vimeo..."
 
4. Enter name and embed code
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Enter name to refer to this video and embed code from service provider.
 
5. Video appears in the video library
 

 
Now your video is in project's video library and you can embed it into topics.
 
6. Click "Insert Video"
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Select a topic to insert video into, place cursor where you want your video to appear and click "Insert Video"
on the editor tool bar.
 
7. Placeholder appears
 

 
Video placeholder appears in the position of cursor. Now Helpinator will insert your YouTube video into
compiled documentation if the selected output format supports video. 
 

Change order and hierarchy of topics quickly

Version 3.11.3 introduces new feature called “Advanced rearrange”. It allows to quickly change order, titles
and hierarchy of multiple topics at once. Normally Helpinator allows to change order of topics and their
position in the topic tree by dragging and dropping topics in the topic manager. It is good for a topic or two but
is very uncomfortable and time-consuming when you need to change places of several topics in a large
project (say, after mass-importing html/rtf files).

To activate this feature select “Topics” node and click the button shown on the image below.
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Rearrange topics

It opens up “Advanced rearrange” window. This window is a simple plain text editor with a topics tree
converted to it’s plain text representation. Each line has a topic title and topic id in brackets at the end of the
line. If a topic is a subtopic, it’s line starts with a TAB (one for level 1 subtopics, two TABS for level 2 and so
on).
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Advanced Rearrange

What you can do here:

1. Cut/Paste topics en masse. Select several lines with your mouse or Shift+cursor, click Ctrl+X to cut
them, place cursor into their new location and click “Ctrl+V” to paste. 

2. Change levels – just insert/remove TABs at the beginning of the line. To move several topics to another
level (e.g. to insert TAB into several lines) select them as told above and click “Increase Level”. This will
insert TABs into several lines at once. “Decrease level” works the same way. 

3. Rename topics. It’s OK to change topic titles as long as you keep ID part at the end of each line intact.

What you CAN’T do:

1. Change or delete topic IDs. They are used for identification, so it will cause an error. 

2. Delete topics – to delete topics please use corresponding command of the topic manager. Deleting
topics here will cause an error. 

3. Add new topics – the same as with “Delete topics” issue, use “Add topics” command from the topic
manager.

Create a FAQ

 
1. Select "FAQ" node
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Select "FAQs" node in the project tree view.
 
2. Add a new FAQ
 

 
Click "+" sign to add a new FAQ.
 
3. Enter FAQ name
 

 
Enter short FAQ name to reference it.
 
4. Add a FAQ section
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Click "+" sign under "Sections" group to add a new FAQ section.
 
5. Add a question
 

 
Click "+" sign under "Questions" group to add a new question.
 
6. Edit question
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Edit question text and answer. Question text is plain text, answer is rich text like any topic.
 
7. Embed
 

 
You can embed your newly created FAQ into a topic with FAQ pseudo tag. It will be replaces with an actual
FAQ at compile time.
 

Create a Quiz

 
1. Select "Quizzes" node
 

 
Select "Quizzes" node in the project tree view.
 
2. Add a new quiz
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Click "+" button to add a new Quiz
 
3. Open editor
 

 
Double click the newly create quiz to open quiz editor
 
4. Add a question
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Click "+" icon to add question, write question text in "Question" tab.
 
5. Set up answers
 

 
Select answers numbering, multiple correct answers and how options will be generated.
 
6. Embed into a topic
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Embed a quiz into a topic with "QUIZ" tag.
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Getting Started

This topic will help you to make quick start and learn basics of Helpinator in under a few minutes.

First off, take a look at UI Overview.
Next, learn Helpinator Project structure, what types of items does it contain?
Then start a new project.
And finally know what formats Helpinator supports and how to compile help files.

UI Overview

Helpinator has classical explorer-like UI with open/compile project buttons on the main toolbar and all project
items organized in the project tree view.

UI Overview

Project Structure

The picture below shows Helpinator project structure.
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Project Structure

You are not forced to create all items shown above. In fact, you only need some topics and templates to
create documentation.

Output Formats

Currently Helpinator supports the following output formats:
1. MajorMindHelp - our own HTML-based help system 
2. LiteHelp - our own lightweight help system NOT based on HTML
3. SimpleDocServer
4. CHM (Microsoft HTML Help)
5. PDF (Adobe Acrobat)
6. RTF (Rich Text Format)
7. DOCX (Word 2010+)
8. Classic WebHelp (HTML based with navigation and 3 options: with frames, without frames and single

page).
9. WebHelp-JqueryUI (responsive HTML without frames, uses JQuery UI as a UI framework)
10. WebHelp-Bootstrap (uses Bootstrap as a UI framework)
11. QtHelp (Qt library native help file format)
12. JavaHelp (Java native help file format)
13. EPUB - widespread ebook format
14. MOBI - Amazon Kindle format.
15. OracleHelp - help system from Oracle Inc
16. HelpGUI - a lightweight help system for Java
17. WordPress CMS
18. Github Flavoured Markdown (for readme.md of your projects, Github Wiki and Github pages).
19. Knowledge Base
20. Mobile Help - JQuery Mobile, touch-friendly output for displaying help on mobiles and tablets, based on

JQuery Mobile.
21. Single Page HTML
22. LeanPub manuscripts
23. reStructuredText - for use with the excellent readthedocs.io service
24. ASCIIDoc - if you want to employ the power of ASCIIDoc/ASCIIDoctor documentation generators.
25. DITA - established documentation authoring standard with a lot of output formats and tools that support it.
26. Docbook - another industry standard documentation format.
27. Old good plain text to create good formatted readme.txt for your projects.
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Project

Project options define global project-wide settings.

Project Options

Option How it works

Auto generate Context IDs Helpinator will generate unique context ID every time
you add a new topic or anchor

Auto Index

If this option is checked you don't need to assign
keywords to each topic. Just fill the list of project
keywords and Helpinator will assign them to topics
automatically, based on topic content.

Auto number topics... Helpinator will put sequential topic number in front of
topic title when generating help files.

Clicking on "PDF/Print settings" opens up "PDF settings" dialog. First page "General" allows you to define
special fields of PDF document.
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General Project Options

The second acts both for PDF and for printed manuals. Here you can define margins, orientation and paper
size.

PDF Settings
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Variables

Variables play important part in Helpinator project:
1. They contain info that changes frequently, like version number.
2. They are used in templates to insert product name, version, edition and etc, so you don't need to alter

templates for that kind of stuff.
3. They help to control conditional compilation. You can get two different help files from the same source

changing one or more variables before compilation.

All variables are located on the "Variables" tab of Project Options.

Variables

"Presets" are the easy way to switch sets of variable values and are especially useful in conditional
compilation.

In the example above variable "EDITION" has the value "STD" in the preset named "STANDARD" and "PRO"
in the preset named "PROFESSIONAL". Select active preset before compilation to set variable values.

Storage Modes

Helpinator has two storage modes:
1. Single-file mode. Everything is in one zip-compatible project file with .hpz extension. Good if you don't use
VCS system or want to deal with one file.
2. VCS-friendly mode. In this mode Helpinator stores every item in a separate file (or several files) and
updates only changed files. So you don't need to check-in entire project every time you change something.

Helpinator 3.23 Manual

93



Modes are interchangeable. You can zip project folder (with project.xml in the root) and change extension
from zip to hpz and work with your project in single-file mode. Or you can extract everything from hpz file and
work in VCS-friendly mode.
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Topics and Content

Topics are the basis of your help project. Topics may contain formatted text, tables, images, code and text
snippets, step-by-step guides. Topics have language-specific title, project-wide unique ID, context ID to
connect to your app and a list of assigned keywords.

You can assign tasks and notes to topics for advanced management purposes. Topics also may be skipped
from output based on a set of conditions.

Topic editor UI is similar to any other text processor UI with some additions related to Helpinator and help
authoring in general.

Manage Topics

Topic manager resides under "Topics" node of the project tree view.

Manage Topics

When you click "Add several topics" separate dialog box appears:
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Add several topics

Here you can add a bunch of topics as children of the selected topic and also with hierarchy. Just start new
levels with TAB.

Classic Toolbar WYSIWYG Editor

Text authoring UI of Helpinator is similar to any other text processor. It has common text formatting toolbars,
as well as Helpinator-specific object insertion commands, like "insert code snippet" and other. It also allows
you to apply named text and paragraph styles to  selected text.

Images below show what each toolbar button is for:

Helpinator 3.23 Manual

96



Below editor area there's topic settings tab set:

Click "..." to open "Topic keywords" dialog. It allows to select from keywords already existing in the project,
added new keywords manually or using a list of suggested keywords.
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"ToDo" tab contains simple todo list of tasks assigned to this topic. Later on you can review all tasks
assigned to all topics in global tasks manager ("Tasks" node of the project tree view) or using the report
"Tasks by topic" that shows a list of tasks grouped by topic.
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Notes allows you to write down something related to this topic. This combined with "COMMENT" tag makes
a good tool for text reviews.

Sometimes you need different HTML template for a topic (for example, default, title topic, with big company
logo). You can select what template to use - default or maybe special template.

Anchors allow you to reference certain place in this topic, either using a hyperlink or context-sensitive help
call using "Context ID".

"Skip topic" tab allows you to skip current topic from output based on:
1. Condition - using variables. See "Conditional compilation" for more details.
2. Skip from certain formats. For example, when topic contains video, it should be exported to CHM and
WebHelp, but not PDF and RTF.
3. Skip always - select this mode if this topic is not ready yet.

Tabbed Toolbar Editor

Classic editor toolbar is too cluttered and overloaded so we introduced a little bit improved tabbed toolbar that
has similar functions, divided into categories. It has 4 tabs: "Write", "Insert", "Table" and "Tools".
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"Write" tab has all basic writing functions like fonts, lists and etc.
"Insert" tab allows to insert dedicated content pieces of Helpinator - Screenshots, text snippets, code
snippets, step-by-step guides, videos, admonitions, faqs and quizzes.
"Table" allows to insert and manipulate tables.
"Tools" tab contains text processing tools like copy-paste, spellchecker and etc.

"Write" Tab

"Insert" tab

"Table" tab
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"Tools" tab
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Styles

You can add named styles for virtually any object in Helpinator. Global named styles allow you to keep the
same formatting everywhere and change the way items look in a matter of few clicks.

Styles

Text and Paragraph Styles
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Text Style
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Paragraph style

Table Styles

Table styles allow you to keep the same table formatting in all topics.
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Table Styles

To use table style you can either select it in the "Insert table" dialog  or from "Cell properties" dialog of
WYSIWYG topic editor.

Shape Styles

Shape styles allow you to define common settings for different shapes that you can add in the image editor.
You can select line styles, colors for lines and background and font settings for text inside shapes.
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Shape Styles

To use created style you can select it from the drop-down list in the image editor toolbar. This style will be
used for shapes that you add. To change the style of the selected shape double-click it to open shape
properties and select style in the dialog that appear.
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Select shape

Select a shape style

Guide Styles
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Guide styles allow you to change appearance of Step-by-step Guides in compiled documentation. Most of it
Helpinator uses only when compiling CHM and WebHelp, PDF/RTF/Printed Manuals do not use "slideshow"
effect, so only font settings will be taken into account when compiling them.

Guide Styles

CSS tab contains highlighted CSS code that will be inserted into HTML-based help output (CHM and
WebHelp).
Here you have more control over Guide appearance in this kind of documentation, but be careful.
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CSS of Guide Styles

To use your newly created guide style select it from corresponding drop-down list in the guide options area.
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Assign new style to a guide
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Manage Glossary

Helpinator allows you to create, manage and reference Glossary of terms specific to your project. 

Glossary

To insert a link to a glossary term use "Glossary" tab in the "Insert Hyperlink" editor dialog:
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Insert a glossary hyperlink
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Images

There are two ways to use images in Helpinator:
1. Regular images, embedded into topics
2. Library images, stored in the project's Image Library and referenced from one or more topics.

The first one is similar to other Help Authoring Tools and text processors
The second is far more efficient from the productivity point of view, since all your images are in one place and
you don't need to browse through project topics to update them when something changes in your program's
UI. Beside that:
o Image Library allows you to add annotations to images, so you can make more understandable help files.
o Image library allows you to create "cloned" images. Clones are exact copies of "donors" and update the

same moment you update "donor" image. But they have different annotations, so you can create a bunch
of images with different annotations from the same screenshot. Once UI changes you only have to update
one image and the rest will be updated automatically!

o Image Library has categories for images, so it is easy to manage a large project with a lot of images in it.
o You can create "step-by-step guides" from images stores in the image library.

Managing Images

Image Library UI has a toolbar with commands and tree list of images, organized into categories.

Image Library
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Toolbar has the following commands:
1. Add Image from file
2. Rename image (selected images)
3. Delete image (selected images)
4. Assign new category to selected images
5. Resize selected images
6. Export selected images
7. New blank image
8. New cloned image

Add Image from file opens up separate dialog:

Add image from file

"Resize selected images" command allows you to resize images that have width in pixels more than selected
value. This is useful when you have captured a bunch of screenshots that do not fit browser or PDF page
width.

Resize Images

"New blank image" allows you to create an image with user defined size and filled with selected color. Using
it and annotations you can create diagrams like this:
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Shapes drawn above a blank image

New Blank Image

"Cloned" images are explained in detail in this topic: "Cloned Images"

Image Editor

Helpinator has built-in image editor that allows you to add arrows, boxes with text and other useful content to
images in the project's image library.
Image editor is fairly simple to use. The figure below explains pretty much everything. Select shape style (or
"None" if you do not need it), shape on the toolbar and drop it somewhere.
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Image editor explained

The "Tools" menu of the image editor has some handy commands you can use:

Image editor tools
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o Extend image canvas - allows to make a screenshot larger by adding extra blank space.
o Show grid - shows shape alignment grid - disable it if it annoys you.
o Replace Image (From File) - replace the image bitmap/background using the selected file. Shapes will

stay intact.
o Replace Image (From Clipboard) - replace the image bitmap/background using the image currently in the

Clipboard. Shapes will stay intact.
o Export image - save image to file, with all shapes rendered over bitmap.
o Change active region - allows to define "active" region of the image. Active region limits the area where

you can place shapes and allows to apply some effects to the space outside of it (darken, blur, crop).
o Stop changing active region - disables active region resizer.
o Effect for inactive region - allows to select an effect that you want to apply to the area outside of the

active region (keep it as is, blur, darken, crop).
o Crop image to active region - crop the image so it will match the defined active region. Basically it is just

"Crop" command from any other image editor. Operation is irreversible! Not applicable to cloned images.
o Make this image a clone of... - allows to change the donor of the cloned image or turn the image into a

cloned one.
o Unclone - break the link between the clone and donor, the image will no longer update automatically

when the donor image updates.

Using Images

You can use images in one of the following ways:
1. Inside topics or other textual content pieces.
2. In step-by-step guides.

Step-by-step guides have their own topic, here we'll talk about inserting images into topics.

You are not forced to use Image Library, you can add images into topics as in usual text processor, using the
toolbar button shown below.

Insert inline picture

Inserting library images is not very different from it. Click on a toolbar button and select an image from the
drop-down list. Note that images are grouped by category.
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Insert Screenshot / Figure

Now when you change an image in the image library it is automatically updated in all topics that reference it.

There are other options available:
1. "Insert Screenshot / Figure From File..." - use it if you have an image on your hard drive and want to

insert in the position of caret and into the project library at the same time.
2. "Paste screenshot from Clipboard" - use it if the image is in clipboard, obtained by Ctrl-PrtScr or other

screenshot capture tool.
3. "Quick search for an image" - allows you to quickly locate image in the project library by it's name.

How it works:
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Quick search for an image

Type a part of image name into the edit box at the top of the window and it will filter out images that do not
match the criteria. Now you can select one or more images with checkboxes and click "Insert" to place them
in the position of caret.

Cloned Images

Helpinator’s “Image Library” allows you to create “cloned” images. What are they?

Let’s say you have a big complicated tool bar in your application. You need to explain your users how to work
with it, what buttons trigger specific actions, all grouped by specific tasks… This probably will require a lot of
copies of the toolbar image, each one with it’s own callouts, arrows and text boxes, but all with the same
background – application toolbar.

Now suppose that during project evolution toolbar changes significantly – updated icons, some new buttons.
Now you need to update a bunch of images to reflect changes in the UI. That could be a nightmare! But not if
you use Helpinator’s image library and “cloned” images.

In the following example will’ take a look at one simple but very common situation. Suppose you have a set of
images in your project, describing different parts of the toolbar, but all of them contain application name and
version in the window title like this:

One image has callouts for language bar:

Helpinator 3.23 Manual

119



Another for compile buttons, and so on…

We’ll make the first one “donor” image and two other images will be cloned.

New cloned image

Now suppose application version changes to 3.5. You need to update all those images. Luckily you have only
one donor image and two clones, so you only need to update one image.

Select Tools->Replace Image when donor image is open in the editor.
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Replace bitmap

Now all cloned images are updated:

There's also a handy feature that is called "Active region". It allows to use only a square portion of the donor
image. Define active region and set "Effect for..." to "Crop".
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Change active region

Example.

This image is the large donor image. But we do not need it as a whole, more than that, it will be discussed in
different topics.
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Donor

So we can create two clones and define different active regions for them.

Clone 1

Clone 2

Paste from Clipboard

If you prefer to use another screenshot capture tool or just Windows PrntScrn built-in function Helpinator
allows to quickly add captured screenshot from the Clipboard. Just place the cursor in the topic editor where

Helpinator 3.23 Manual

123



you want to place the screenshot and click "Ctrl+Alt+V" or select "Paste Screenshot from Clipboard" in the
right-click pop-up menu.

"Paste screenshot..." dialog appears. Select image name, format and category, then click "Paste".

Paste from Clipboard
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How to Work With Video

From version 3.11 Helpinator allows you to embed video into topics. You can embed videos from video service
providers like YouTube, Vimeo, DailyMotion or from local video files.

To start working with videos select "Video" node in the project tree view.

"Video" tree node

If there's no "Video" node click "Show Videos" on the tree view control bar on the left.

Tree filter for Video

Video manager appears:
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The Video Manager

When you click "+" sign "Add from files" dialog appears. Click "Add files" to select one or more video files to
add then click "OK".

Add a video from file

When you click on YouTube sign "Add from URL" dialog appears:
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Add video from URL

To insert video placeholder into a topic click on video icon on the topic editor toolbar.

Insert Video into a topic

Helpinator inserts video placeholder in the position of caret. Now on compile time this placeholder will be
replaced with your video.
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Some formats like PDF or printed output do not support video. You can instruct Helpinator to replace video
with a library image or a step-by-step guide via image properties.
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Video in a topic editor
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Step-by-step Guides

Step-by-step guides allow you to document procedures that users have to follow to accomplish certain task.
Each guide consists of steps. You can add as many steps as you want, but it's a good idea to limit yourself
to 10-15. Each step has:
1. Title
2. Descriptive text about actions to perform on this step
3. Image from project's Image Library. You can use plain images/screenshots, but it's better to annotate

them. If your guide uses lots of similar images with different annotations - then you might want to use
cloned images for steps.

Helpinator stores all guides in a place similar to Image Library.

Manage guides

How to create a step-by-step guide

 
1. Prepare images
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Prepare images for your guide. You can add existing images to the image library, capture some screenshots
or create cloned images. Add callouts using image editor to emphasize meaning of the corresponding step.
 
2. Select guides node
 

 
Select "Step-by-step Guides" node in the project tree view.
 
3. Click "Add Guide"
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Click "Add Guide". New guide dialog box appears.
 
4. Name your guide
 

 
Give appropriate name to your guide. It is recommended to avoid use of spaces and special characters since
this name will be used in "SBS" placeholder.
 
5. Create topic
 

 
Check "Add topic" to automatically add topic with created guide. It will be added as the last topic in the
project. You can use project tree drag and drop feature to put it in the correct place. 
If you leave it unchecked then you need to manually insert "SBS" placeholder into desired topic.
 
6. Add images
 

Helpinator 3.23 Manual

132



 
Click "Add images" button to add images for steps. You will be able to rearrange and rename steps later.
 
7. Select images to add to the guide
 

 
Select images for steps. Images are taken from the project's image library. Check as many images as you
wish.
 
8. List of steps
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The list of steps is at the left top corner of the guide editor. On top of the list there are tool buttons to edit it.
 
9. Give short names to each step
 

 
Click "Rename" to give appropriate titles for steps. 
 
10. Put steps in the correct order
 

 
Reorder steps using "Up" and "Down" buttons.
 
11. Add descriptive text for each step
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Write some descriptive text for each step. Be short, image should say for itself.
 
12. Set up guide options
 

 
Guide options are at the left bottom row. Here you can select whether you want to add step numbers to step
images, select color scheme to use for step numbers and where they should be located on the step image.
Check "Auto size" if you want Helpinator to select size of the HTML box automatically, or set width and height
manually.
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How to use guides in topics

There's "Insert step-by-step guide" button on the topic editor toolbar.

Click on "Insert step-by-step guide" and select it from the drop-down list.

Insert a step-by-step guide

When you select a guide, guide placeholder appears in the editor area in the position of cursor.

Placeholder for a step-by-step guide

Helpinator 3.23 Manual

136



Text Snippets

Text snippets are named reusable blocks of formatted text that you can create once and use in many topics.
Note that since version 3.19 Helpinator has dedicated content piece called "Aside" and you no longer are
forced to use text snippets to create asides.

The picture below shows how to manage text snippets.

Manage Text Snippets

There are two types of text snippets:
1. Simple pieces of formatted text
2. Parameterized snippets, that contain special placeholder TEXTFORSNIPPET which Helpinator replaces

with text from the topic.

Here's an example of the second type text snippet:
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Edit text snippet

How to use text snippets

In this example we use "warning" box created in previous topic:

Warning
This text is for "Warning" box.
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How it will look like in CHM help file:
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Code Snippets

Code snippets are portions of code or markup with syntax highlight. Helpinator allows you to manage code
snippets using snippet library and embed them into topics using special placeholders. Though Helpinator is
not intended to document source code, code snippets allow you to document APIs, HTML/XML samples and
other supplementary code.

The picture below shows how to use code snippets manager.

Code Snippet Manager

Code snippet editor allows you to view and edit code snippet with syntax highlighting. You can also change
highlighting for the snippet.
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Code Snippet

How to use code snippets

 
1. Click toolbar button
 

 
Locate "Insert code snippet" button on the topic editor toolbar and click it.
 
2. Select snippet
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Drop-down list of available code snippets appears. Select code snippet to insert.
 
3. Placeholder appears
 

 
Code snippet placeholder appears in the position of caret.
 

Code snippets in help files

This is how a code snippet looks in CHM help file and WebHelp:
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Code Snippet in a CHM

And in PDF/RTF/Printed Manuals:

Code Snippet in a PDF
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Templates

Helpinator has template engine that uses layout templates for all supported formats when producing help files
and documentation. Generally layout templates are divided into two groups:
1. HTML-based templates for producing CHM help files, WebHelp, QtHelp, JavaHelp and EPUB/MOBI.
2. RTF templates for producing RTF, PDF and printed manuals.

Helpinator comes with several predefined templates that you can use in your projects.

Templates are stored inside the project, so you need to add them first to allow Helpinator to use them.

Project templates
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Template nodes in the project tree view

HTML-based Templates

Each CHM/WebHelp template consists of two file groups:
1. Required files. Usually templates' main HTML page template and corresponding CSS file.
2. Additional files. Images used by template, scripts and etc.

In predefined templates there's jqueryui.zip file that contains JQuery UI theme for WebHelp (left pane with
TOC, Index and Search). Inside it there's jqueryui.css and jqueryui.js files and "images" folder with images
used by this theme.

HTML templates use several tags, enclosed in {%%}:
Tag Meaning

TITLE Title of the current topic
BREADCRUMBS Place for breadcrumbs links
PREVNEXTTOPIC Links to previous and next topics, combined
PREVTOPIC Link to previous topic
NEXTTOPIC Link to next topic

PREVTOPIC_INCL Link to previous topic, but instead of "Previous" text it uses HTML
between this tag and END_PREVTOPIC_INCL tag.

NEXTTOPIC_INCL Same as above but for next topic
SEEALSO Lists related topics based on keywords match.

You can also use project variables inside templates.
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HTML templates
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Inside an HTML template

Adapting WebHelp to your website

You can also adapt WebHelp appearance to the style of your website using WebHelp header and footer. This
fields are not required, if empty WebHelp will fill entire browser page. When filled, header and footer will
appear in separate frames.
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WebHelp Addons

PDF/RTF/Print Templates

PDF/RTF/Print templates are generally RTF files with several reserved pages:
1. Cover page. Will be rendered without header and footer. Here you can place your logo and project title.
2. Table of contents page. Has a number of lines, starting with LEVEL and followed by number indicating for

which sublevel this line should be used. Top level topics are level 1 and so on.
3. Topic template. Ususally has only TITLE and CONTENT tags, TITLE will be replaced by topic title and

CONTENT with topic content.
4. Glossary template. Has templates for the first letter, term and definition.
5. Index page template. This page will list keywords and numbers of pages where they appear.
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PDF/RTF templates
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Header, Footer and Cover page template

Table of Contents

Helpinator 3.23 Manual

152



Page Template
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Tools

Helpinator has several built-in accompanying tools to make your help authoring process less frustrating. All of
them are under "Tools" node of the project tree view.

Tools

Currently Helpinator has the following tools:

1. Search and Replace. Allows you to find and replace text string in all topics of your project.
2. Context IDs. Allows to edit all topic Context IDs in one place.
3. Screenshots. Allows to take screenshots, apply effects and store them to the project's image library.
4. Global Spellcheck. Check spelling in all topics of your project.
5. Image Tools. Group of tools for image processing.
6. Check Links - to find broken internal and external links.
7. REImport - if a topic was imported from a file, you can import it again if an external file was changed.
8. WordPress Theme Builder - helps you to create a specialized software documentation theme for

WordPress.
9. GIF Screen Recorder - allows to record short animated GIFs instead of static screenshots.

Search and Replace

"Search and Replace" tool allows you to get a list of topics where certain phrase appears and optionally
replace those occurrences.

Helpinator 3.23 Manual

154



Search and Replace

To replace a text everywhere in your project:
1. Check "Replace" option.
2. Enter text to replace "text to find" with.
3. Click "Go"

Context IDs

"Context IDs" tool allows you to review and edit Context IDs, used to connect help files topics with your
application, in one list.
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Context Ids

Screenshots

"Screenshots" tool allows you to capture screenshots, store them to the project's image library, create new
topics and guides with captured images and more.

At the top of the window there are hotkey selector and start/stop button to start capture process.

Below is the settings tab set.
"General" tab allows you to select whether you want to capture new image and put it into specific category or
recapture existing image.
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Screenshot Tool

"Create topics and guides" tab allows you to create content elements when a new screenshot is captured.
You can:
1. Create new topic containing captured image
2. Append captured image to existing topic
3. Create a new step-by-step guide. The new guide will be created on the first capture after you click "Start".

All captures after that will be appended to this guide.
4. Append to Guide - newly captured images will be added as new steps to existing guide.
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Screenshot - create topics and guides

"Region and background" tab allows you to select what you want to capture.
You can:
1. Capture active window only
2. Capture entire desktop area
3. Capture rectangular area around mouse cursor. In this mode you have to specify offsets in pixels from

current mouse position that define rectangular area.
4. Capture mouse cursor - allows to put current mouse cursor on the screenshot.
5. Capture background - allows to capture rectangular area surrounding current capture rectangle. You can

specify what part of the background to capture, effects to apply to it (you might want to darken or blur it)
and make capture rectangle to "drop shadow" on background.
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Screenshots - capture region

Global Spellcheck

"Global Spellcheck" tool allows you to check and fix spelling in all topics. Though Helpinator has check-as-
you-type spellcheck in the topic editor, you might want to check all topics for example after you imported
some documents using file import/export feature.
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Global Spellcheck

Image Tools

Image tools is a set of tools targeted at batch image transformation using project's image library.

Currently it has only one tool - "Move Images To The Library". It allows you to move all images from topics
into the project's image library thus allowing to edit, reuse and recapture them. This is useful when your
project is partially a product of conversion/import.
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Image Tools

Check Links

This tool allows you to find broken links in all topics of the project automatically. It shows a report grid with
link details and a name of the topic where the broken link was found.
You can edit links right in the grid and then click "Fix links". For each link you can select to:
1. Replace broken link with a new URL
2. Remove link
3. Skip this item during next check.
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Check Links

REImport

REImport tool allows you to import again external files that were changed since they were imported.
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REimport

WordPress Theme Builder

WordPress theme builder allows you to create a custom WordPress software documentation theme. The
majority of WordPress themes do not suit software documentation well, Helpinator theme solves this
problem. It makes your WordPress site look like a regular help file with tri-pane on the left featuring "Table Of
Contents", "Index" and "Search" and content area on the right.
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WordPress Theme Builder - Parameters

Helpinator 3.23 Manual

164



WordPress Theme Builder - Colors and Fonts

GIF Screen Recorder

GIF Screen recorder allows to record short animated GIF files instead of static screenshots. You can select
what area do you want to record - fixed rectangle around the mouse cursor or an active window and redefine a
shortcut that starts and stops recording.
When you finish recording captured frames appear in the "Preview" area. If you are happy with it you can click
"Create GIF" and store the file in the project's Image Library.
Later you can use it in topics and step-by-step guides.
However, remember that animated files break single-sourcing, PDF and printed manuals allow only static
images.
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GIF Screen Recorder
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Reports

Reports allow you to get summary information about your project and save/print it.

Currently Helpinator has the following predefined reports:

1. Topic titles and IDs. Shows topic titles and corresponding Context IDs to reference specific topics from
your app. Useful for communication between a tech writer and a developer.

2. Empty topics. Shows all empty topics in the project. Good to make sure all topics in your project have at
least some text.

3. Tasks by topics. To manage tasks assigned to topics.
4. Project stats. Shows different project stats like number of topics, words and etc.
5. Topic structure. Prints topic tree.

Reports
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Reports - created report

Helpinator 3.23 Manual

168



ToDo List

Helpinator allows you to create and manage to-do lists - both for individual topics and the project as a whole.
Using this little feature you are able to:
1. Control your tech writers. Of course, this is not a full-featured project planner app with team features, but

good enough for small teams and interacting with contractors.
2. Keep your global to-do list free from small tasks associated with this project.
3. Go to the place where a task should be accomplished, without wasting time on finding it.
4. Never forget to to something on your project.

There are two places to work with tasks:

1. "ToDo" tab at the bottom of the topic editor. This tab allows to add/manage tasks assigned to this topic.

Topic todos

2. Global project to-do list with all tasks from all topics and the project itself.
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Global Tasks

To add a task for the project itself, not a topic, click "Add" in this global list.

There's also a way to get printed version of your tasks list. Locate "Tasks by topics" report under "Reports"
node and run it.

"Tasks by Topics" report
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Formats

Helpinator supports the following output formats:
1. CHM (Compiled HTML Help)
2. PDF
3. RTF (with some limitations)
4. WebHelp (Classic (with frames), based on JQuery UI framework, based on Bootstrap framework)
5. Knowledge Base
6. Printed manuals
7. QtHelp (Qt Library native help file format)
8. JavaHelp/OracleHelp (Java native help file format)
9. EPUB (e-books format)
10. MOBI (Kindle e-books format).
11. OracleHelp
12. HelpGUI
13. MajorMindHelp
14. LiteHelp
15. SimpleDocServer
16. LeanPub
17. GitHub-flavored Markdown (for ReadMe.MD, GitHub Pages and GitHub Wiki).
18. ReadTheDocs.org (reStructuredText)
19. Publish to Wordpress CMS
20. MobileHelp - JQuery Mobile

CHM, WebHelp, QtHelp, JavaHelp, EPUB and MOBI are all HTML-based and rely on HTML-based templates.
JavaHelp uses reduced set of HTML features therefore it needs specially formatted HTML templates.
EPUB/MOBI are book-oriented and HTML templates for them also differ in formatting and structure.

OracleHelp is an advanced HTML-based help system developed by Oracle Inc. It is multilingual, and can be
used as a local help file and WebHelp using the same compiled project.

MajorMindHelp is a multilingual HTML-based help system for desktop Windows apps.
LiteHelp is a lightweight portable non-HTML help system for desktop Windows apps.

Wordpress is the most popular CMS right now, so if you run your project website on this help system you
don't need to mess with non-compatible webhelp systems, you can publish online documentation right to
your CMS.

CHM is primarily Windows-based help file format, though there are some viewer implementations for other
platforms too. WebHelp, QtHelp, JavaHelp, HelpGUI and OracleHelp are cross-platform formats.

PDF, RTF and printed manuals rely on RTF templates. PDF and Printed manuals are almost identical, except
that Printed manuals are sent directly to printer and thus avoid image quality loss during compression. But
PDF files have useful "Outline" with document structure and direct links to topics. RTF files are a limited
version of PDF output, they do not have headers and footers.
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Formats

CHM

Helpinator uses Microsoft HTML Help compiler to compile CHM help files. You need to install it prior to
compiling CHM, otherwise Helpinator will report error. You can download it from Microsoft website or install
htmlhelp.exe from the same zip archive with Helpinator setup.

Helpinator automatically generates "Previous/Next", "Breadcrumbs" and "See also" lists.
If you have Glossary in your project - it will be compiled into CHM file as well.

To connect your CHM help file to your application you need to know Context IDs of topics. To get them in
printed form you can run "Topic Titles and IDs" report under "Reports" node of the project tree view.
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CHM - topic
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CHM - index
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CHM - Search

PDF/RTF

Helpinator generates PDF files with cover page, table of contents, glossary and index based on PDF/RTF
template. TOC consists of hyperlinks, e.g. you can click on topic titles to go to corresponding topic. The
same can be archived using navigation bookmarks tree on the left pane.
Pages have header and footer with page numbers.
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PDF - cover page

Helpinator 3.23 Manual

176



PDF - Table of Contents
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PDF  - topic
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PDF - index

Classic WebHelp

WebHelp is a set of javascript-powered HTML pages with table of contents, index and search feature.
Helpinator uses the same HTML template to compile topic pages that it uses to compile CHM, except it
publishes JQuery UI theme from jqueryui.zip file.
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WebHelp - topic
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WebHelp - index
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WebHelp - search

Analytics and Social Integration

Helpinator allows you to add Google Analytics, AddThis and Disqus integration to WebHelp without altering
HTML templates. All you need to do is to paste integration code provided by these services into
corresponding project options.
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WebHelp analytics and social integration

Adapt to your website

Helpinator allows you to adapt WebHelp to your website design. There's "WebHelp" tab in the CHM/WebHelp
template editor with two groups: "Header" and "Footer". There you can paste HTML code that will be shown
above and below WebHelp panes.

Example can be seen in Helpinator's own WebHelp:

http://www.helpinator.com/webhelp
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Adapt WebHelp to your site

How to Change Style of the Left Pane

WebHelp is based on JQueryUI so you can use it's styles to change style of WebHelp template. Take a look
at "Additional Files" section of default template. There you can see jqueryui.zip file. This file contains all
required style data. The following steps show how to create your own:

1. Go to http://jqueryui.com/themeroller/
2. Select colors that you like, then download corresponging zip archive
3. Unzip it
4. Create another folder were you will place working files
5. Go to "CSS" folder unzipped from the archive.
6. Copy images folder to your new folder
7. Copy jquery-ui-*.css to the root of our new folder, rename it to jqueryui.css
8. Go to "js" folder unzipped from the archive.
9. Copy jquery-ui-*.js file to the root of our new folder, rename it jqueryui.js
10. Zip our new folder (so jqueryui.css and jqueryui.js are in the root of the archive) and name it jqueryui.zip
11. Place it into "default_files" folder or your own template folder, say "mytemplate_files" or remove default file
from project template and add your own instead of it.
12. Voila, you can compile WebHelp with your own color settings.
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WebHelp - JqueryUI

WebHelp - JQueryUI is a major overhaul of Classic WebHelp with the following aims:
1. Avoid usage of frames that are obsolete in HTML by now. 
2. Make it responsive.
3. Make it more SEO-friendly.

General structure of WebHelp-JQueryUI matches that of Classic WebHelp, with "Table Of
Contents"-"Index"-"Search" block on the left side, content block on the right plus customizable header and
footer. But there are some differences as well:
1. Step-by-step guides now use different engine that is modern and responsive.
2. Code snippets highlighter is different too.
3. Images scale automatically when window size changes.
4. Web browser remembers last selected tab and width of the left sidebar.
5. Folder structure is now more neat with "js" subfolder for JavaScript, all images in "images" folder and the

main folder containing only html files.

You can find sample docs here: http://www.helpinator.com/webhelp-jqueryui/about.html

It looks like this:

WebHelp2

Printed Manuals

Printed manuals act the same way and use the same template and settings as PDF format output, but
instead of a file pages are sent directly to printer. When you click "Create printed manual" Helpinator shows
you "Preview" dialog with pages that are about to be printed. You can navigate them, zoom in and out, and
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when you are satisfied - click on "Print" to print them.

Printed Manual

QtHelp

Qt (from Wikipedia) -  is a cross-platform application framework that is widely used for developing application
software with a graphical user interface (GUI) (in which cases Qt is classified as a widget toolkit), and also
used for developing non-GUI programs such as command-line tools and consoles for servers.

You can read entire article here:

http://en.wikipedia.org/wiki/Qt_framework

Qt framework has it's own help file format and framework called QtHelp aimed to provide native help files for
applications written with Qt. You can read detailed description here:

http://doc.qt.digia.com/qt/qthelp-framework.html

Helpinator allows you to create QtHelp files with one mouse click. However you will need QtSDK to do it.
Helpinator will create HTML files and all required QtHelp project files, then it will call help file compiler to
create target help files.
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To compile QtHelp you have to:
1. Download and install QtSDK.
2. Run Helpinator and select Main Menu->Tools->Options, then select "Compilers tab"
3. Find QtSDK path line and enter path to BIN folder of QtSDK.

Note that to use Step-by-step Guides in your help files you will need QtSDK 4.8 and higher.

Options - Compilers - Qt

Resulting documentation looks like this:
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QtHelp - Contents
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QtHelp - Index
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QtHelp - Search

JavaHelp

JavaHelp (from Wikipedia) is both an application and a format for online help files that can be displayed by the
JavaHelp browser.[1] It is written in Java, and is mainly used in Java applications. It can be used for any
application and it does require the overhead of the JRE to load.

The file format is XML.

The GUI uses a tri-pane layout, with a toolbar and menu at the top, navigation pane on the left, and content
viewer on the right. The navigation pane includes searching, indexing, and a table of contents.

Official website:

http://javahelp.java.net/

Helpinator allows you to create all required HTML and project files and automatically calls compiler that
creates help file in JAR format.

To compile JavaHelp:
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1. Download and install JDK.
2. Download and install JavaHelp SDK

http://download.java.net/javadesktop/javahelp/javahelp2_0_05.zip

3. Run Helpinator, select Main Menu->Tools->Options and enter both paths to JDK and JavaHelp "bin"
folders.

JavaHelp Compiler Options

Note that JavaHelp uses obsolete HTML viewer not capable of handling modern HTML features therefore it
requires separate HTML template, default templates for CHM/WebHelp/QtHelp are not compatible with this
output format.

Compiled JavaHelp file looks like this:
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JavaHelp - Contents
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JavaHelp - Index
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JavaHelp - Search

EPUB

EPUB (from Wikipedia) (short for electronic publication; alternatively capitalized as ePub, ePUB, EPub, or
epub, with "EPUB" preferred by the vendor) is a free and open e-book standard by the International Digital
Publishing Forum (IDPF). Files have the extension .epub.

You can read more about this format:

http://en.wikipedia.org/wiki/EPUB

http://idpf.org/epub
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Helpinator allows you to create EPUB books with one mouse click. All you have to do is:

1. Select template for this format in project options.
2. Install one of the available EPUB viewers to preview compiled ebook. For example you can use
CoolReader:

http://www.coolreader.org/

HTML Templates for EPUB/MOBI formats are different from those used in CHM/WebHelp/QtHelp/JavaHelp.
Though they too have <templatename.html> and <templatename.css> files, their logical structure is different:
1. Default HTML file defines how a book page looks like.
2. There are 2 additional HTML files: front.html and toc.html, the first for "front page" with title, author and

etc and the second is for the table of contents.
3. Default CSS file is for all 3 template HTML files.

MOBI

MOBI is a ebook format introduced by a company called Mobipocket. Now it is used in Amazon Kindle
devices. Helpinator allows you to create MOBI ebooks with single mouse click.

To compile MOBI format ebooks you need KindleGen utility from Amazon:

http://www.amazon.com/gp/feature.html?ie=UTF8&docId=1000765211

To compile MOBI ebook:
1. Donwload and install KindleGen
2. Run Helpinator, select Main Menu->Tools->Options, "Compilers" tab and enter path to KindleGen utility.
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KindleGen

You might also need a MOBI viewer (Mobipocket Reader for example or Kindle Previewer).

Note that you can add a cover page image to your ebook (actually Amazon suggests you have one). Just put
a file named syscoverpage.jpg into the project's image library and Helpinator will use it as a cover page for
your ebook.
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Kindle Book Preview

OracleHelp

OracleHelp is a help system, developed by Oracle Inc. You can read more about it here:

http://www.oracle.com/technetwork/topics/index-083946.html

It consists of two parts:

1. OracleHelp for Java
2. OracleHelp for Web

Both parts use the same help file format (except Web version requires one more file) and Helpinator
generates files that can be used with any of them.

To compile OracleHelp:

1. Download and install JDK

2. Download and extract OracleHelp SDK

http://www.oracle.com/technetwork/developer-tools/help/utilsoft-ohw-422139.html

3. Set Helpinator options

Now you can compile OracleHelp by clicking "Compile OracleHelp" button on the main toolbar.
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Compiled OracleHelp looks like this.
Table of contents:

OracleHelp Table Of Contents

Topic view (undocked)
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QtHelp Topic Display

HelpGUI

HelpGUI is a lightweight help system for small Java applications. It has no keyword lookup or built-in search,
but the best part is that it is small.

You can download it here:

http://helpgui.sourceforge.net/

To compile HelpGUI:

1. Download and install JDK
2. Set up Helpinator options for JDK just like in case of JavaHelp

Compiled HelpGUI help file looks like this:
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MajorMindHelp

MajorMindHelp is our own help system for Windows applications. It is based on MajorMindHelpViewer - a
viewer utility that is more than just a CHM-alike help system. You can read more about it in topic
MajorMindHelpViewer.

Main features:
1. HTML-based, full-featured help system.
2. Compiles right into Delphi application, no standalone files or help systems required
3. No problems with CHM help files security
4. No problems with WebHelp cross-browser compatibility and security settings.
5. Multilingual. All languages are in one help file and they can be easily switched between.
6. Transparent help file format - just a zip file with HTML and XML in it.

Helpinator compiles MajorMindHelp directly, without any other tools.

Compiled Help looks like this:
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Wordpress CMS

Wordpress is the most popular CMS in the world. If your website is based on Wordpress and you need to
organize online help for your product - you don't need to create separate WebHelp section on your website
aside from Wordpress. With Helpinator you can publish directly to Wordpress and turn topics into pages (not
posts!). So you can use all Wordpress features in your online help!

There's an in-depth tutorial on using Helpinator "Publush to WordPress" feature combined with Helpinator
theme and Quick Publish plugin on Helpinator Blog:

https://www.helpinator.com/blog/2019/09/07/wordpress-for-online-documentation-how-to-use-helpinator-plugin-
and-documentation-themes/

To publish your help file to Wordpress you need to set up your account information and select publishing
options.

Helpinator 3.23 Manual

202

https://www.helpinator.com/blog/2019/09/07/wordpress-for-online-documentation-how-to-use-helpinator-plugin-and-documentation-themes/
https://www.helpinator.com/blog/2019/09/07/wordpress-for-online-documentation-how-to-use-helpinator-plugin-and-documentation-themes/


Publish to WordPress

Helpinator operates "profiles" to manage Wordpress sites. You can have several profiles and publish
documentation to several blogs (test site and the main product site, for example). Click "+" to add new profile
and select profile name.

Then you need to enter account info:
o Blog host address
o Blog "endpoint" (when xmlrpc.php file is in subfolder)
o Whether to use HTTPS for connections
o Username and password
o "Check connection" button allows to test connection requisites

Note that Helpinator does not store your password anywhere for security reasons. If you close Helpinator your
password is lost.
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Publishing settings:
1. Page template - select one of PAGE templates available in your Wordpress theme. Click "Refresh" button
next to it to get a list of templates.
2. Parent Page - a page to assign root page of documentation to. Leave it blank to publish to the main menu.
Click "Refresh" button next to it to get a list of pages.
3. Root page order. By default your documentation root page will be attached to the end of parent page child
pages list. You can change this value to insert it into another place.

Click "Save" to save your account info (without publishing) or "Publish" to publish it right away.

Don't forget to save your project after you publish your documentation, otherwise you will NOT be able to
republish it (e.g. overwrite altered topics).

Major Mind Software provides some useful WordPress plugins and themes for registered users of Helpinator:
1. Helpinator QuickPublish plugin - this plugin extends WordPress API to allow to publish content faster and

also fixes the problem of WordPress API that disrupts image republish feature blocking image rewrite.
2. Helpinator WebHelp WordPress theme - documentation theme that resembles WebHelp 2 in look and

feel.
3. Helpinator Modern Help WordPress theme - responsive theme for software documentation.

You can download plugins and themes here: http://www.helpinator.com/download.html#wordpress

Knowledge Base

Knowledge base is a common documentation layout, without topic tree, or should we say, 2-level tree. There
is no topic hierarchy, topics are grouped into "Categories". The main page has links to all topics. It looks like
this:

To generate a Knowledge Base from an existing project you need to add "kbdefault" template to the project
first.

There's a post on our blog that covers in more detail creation of knowledge bases with Helpinator:
https://www.helpinator.com/blog/2019/09/20/how-to-create-a-knowledge-base-with-step-by-step-guides/
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Understanding Profiles

"Knowledge Base" generator settings are organised into "profiles". Profile allows you to set unique KB
structure that may not match structure of your project. 
Helpinator project is based around topic tree with unlimited levels, KB structure has 2 layers max: Categories
and Articles. Helpinator allows 2 modes for structure transformation:
1. Automatic mode. In this case all first level topics become categories (their content will not appear in the

KB), all lower level topics are combined into a plain list under that category.
2. Manual mode. Allows to define categories then selectively add topics to them and rearrange.

"Structure" tab of profile settings allow to select the mode and do manual operations.

Knowledge base has a sidebar with lists of "Popular" and "Recently updated" articles. To fill these lists you
can use Auto/Manual modes too. Auto mode is equivalent to random in this case.
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You can also define your KB title and tagline or use project title as KB title.
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GitHub-flavored Markdown

Markdown is a plain-text format for writing rich formatted documents. Of course you can create Markdown
files in any text editor but when it comes to handling large projects with images, tables, glossaries and how-
to's, you definitely need a helper tool. Helpinator brings the power of a conventional help authoring tool to the
world of Markdown!

GitHub-flavored markdown is a superset of regular markdown tailored to be used to document GitHub
projects. Basically there are 3 ways you can use Markdown on GitHub:
1. To create a readme.md file in your project root folder. This text GitHub shows when a user visits project

page on GitHub.
2. To create a large project Wiki ("Wiki" tab of the project)
3. To create GitHub Pages - a static project website platform that you can link your own domain to. It is a

kind of free website hosting limited to static sites.

All 3 are Markdown files, but in the first case Helpinator will create a single markdown file from your project
with project title and table of contents. In cases 2 and 3 Helpinator will create one markdown file per project
topic, the difference is in file naming and TOC linking. Besides that Wiki mode allows to create a sidebar with
table of contents for navigation. In all 3 cases images will be published into the "images" folder next to your
markdown files, do not forget to commit this folder using git!

Click "Github-flavored Markdown" icon on the main toolbar, "Export GitHub Markdown" dialog appears.
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To generate README.MD file from your project select the first option "Create readme.md". Here you can
change file name of the output file and tell Helpinator that you want a project title and a table of contents
included. If your project is small you can choose not to add the table of contents. Click OK and the file gets
generated in the "gitmarkdown" sub folder in the folder where your project is stored.

To prepare source files for project Wiki select the second option. You can choose to add optional sidebar
with table of contents for navigation. Helpinator also creates required "Home.md" file that GitHub Wiki uses
as a home page and places project title and table of contents in it. Click "OK" and commit generated files
with "images" sub folder into the Wiki repository (it's name matches your project repository with ".wiki"
postfix added to it).
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To create source files for GitHub Pages select the 3rd option. Helpinator creates one markdown file per topic
plus "index.md" file with table of contents. You'll need to commit them to the root folder or "docs" sub folder of
your repository and set up GitHub pages on the Settings tab of your repository.

Read this blog post for a more detailed tutorial on how to use Helpinator with GitHub markdown:
https://www.helpinator.com/blog/2019/09/23/publishing-github-pages-from-helpinator/

SimpleDocServer

SimpleDocServer is a simple markdown-based web server for light in-house company documentation. It is
very easy to install, has almost zero administration and maintenance costs. You can read more about this
product here: http://www.helpinator.com/simpledocserver.html Though you can easily author
SimpleDocServer content in any text editor since it uses markdown, Helpinator allows to author content more
conveniently. Also it allows you to create context ids for topics so you will be able to use your
SimpleDocServer content as a source of context-sensitive help via MajorMindHelpViewer.

LiteHelp
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LiteHelp is a lightweight help system created by Major Mind Software as a simple alternative to
MajorMindHelp, WebHelp and other highly customizable help systems based on HTML.
It is based on XML, has a limited set of formatting options but has a rich set of embeddable objects supported
by Helpinator:

1. Figures
2. Step-by-step guides
3. Code Snippets
4. Videos
5. FAQs
6. Quizzes

LiteHelp format is basically a set of XML files, so there's no vendor lock-in and there are no security risks
associated with HTML.

LiteHelpViewer is a viewer app for LiteHelp help system. It is a classic viewer with "Contents", "Index" and
"Search" tabs. The executable is portable and self-contained, you can distribute it with your application if your
LiteHelp help system was generated with Helpinator.

You can read more about LiteHelp here: http://www.helpinator.com/litehelp.html

LeanPub

LeanPub is a well-designed and feature-rich platform for publishing ebook and paperback books combined
with a digital storefront to sell your books.
It allows to author your books in plain text, using LeanPub-flavored markdown. Helpinator allows to generate
markdown source project for your LeanPub book from your project.
You can then upload generated content to DropBox or GitHub and allow LeanPub to consume it.

To generate LeanPub source project (manuscript) you can do the following:

Select "Compile LeanPub book" from the "Tools" menu.
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Tools - Compile LeanPub

or create a batch with this command:

Helpinator 3.23 Manual

214



LeanPub batch compile

There's a post on our blog that covers in detail the whole process of publishing your project on LeanPub:
https://www.helpinator.com/blog/2019/08/23/leanpub-tutorial-publishing-your-book-using-helpinator/

ReadTheDocs

ReadTheDocs.org is a nice service for delivering your online documentation to end users, it offers a clean
documentation UI, relies on reStructuredText markup language and version control system as a backbone,
and it is free. Read this blog post on how to generate ReadTheDocs source project from Helpinator:
https://www.helpinator.com/blog/2019/09/23/readthedocs-org-restructuredtext-and-helpinator/

WebHelp - Bootstrap

WebHelp-Bootstrap is WebHelp output like WebHelp-JQueryUI, but based on Bootstrap framework instead. If
your web site or SaaS is built on Bootstrap you can provide docs that use the same framework lessening the
dependencies.

Helpinator's own WebHelp system runs on it: https://www.helpinator.com/webhelp/
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Advanced Topics

The following topics are for advanced users of Helpinator.

Conditional compilation

Conditional compilation allows you to modify Helpinator output based on values of user-defined variables.

It may be used in both of two ways:
1. To skip portions of text
2. To skip one or more topics entirely.

To skip/include portions of text Helpinator has built-in IF directive which has the following syntax:

Conditional Compilation

In the first case IF clause allows to skip the text inside it when "EDITION" variable has "PRO" value.

In the second case the text will be skipped without any conditions. This makes COMMENT tag a good way
for text reviews.

To skip a topic from output completely (e.g. even from TOC) there's "Skip topic" tab in the topic editor

Skip the topic

In the case above Helpinator will skip the topic entirely when EDITION is NOT equal to 'PRO'.
Other options include:
o Skip topic from certain formats - for example a topic contains video samples and you might not want it

in PDF format (since it will be empty) so select "Skip from formats" and check "PDF"
o Skip always - always skip this topic, for example if it's not ready yet.

Command line tool

Helpinator comes with command-line compiler chelpinator.exe that you can use in batch files (.bat, .cmd).
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It has the following parameters:

chelpinator.exe <projectfile> <batchname>

<projectfile> (required) - full path to the Helpinator project you are about to compile.

<batchname> (required) - name of the batch saved to the project file.

Example.

Suppose path to your project is C:\Project\Help\myproject.hpz.

You need to compile PDF help from it and place it into C:\PDF folder. You have variable preset "pro" and want
to use it. You have several languages in the project and you want to use "English (United States)"

You need to do the following:

1. Click on the lightning bolt icon on the main toolbar

2. Click "New batch"

3. Double-click PDF output on the left to add it to the batch

4. Set output path to "C:\PDF"

5. Save the batch with a meaningful name like "mypdf".

6. Save proejct file.

Now you can call command line compiler to produce PDF:

chelpinator.exe "C:\Project\Help\myproject.hpz" "mypdf"

Organizing text reviews

Helpinator allows you to organize text reviews by team members not involved in authoring process. For
example, you have a dedicated tech writer and a group of developers and experts who are concentrated on
development and communicate with a tech writer only occasionally. You need to organize help project
reviews, say, once a month, when other team members can read documentation and leave their comments.
The problem is how to connect comments and topic content without affecting it.

With Helpinator you have two ways to do it:
1. "Notes" tab in the topic editor allows you to write any topic-related text there.
2. "COMMENT" conditional compilation tag allows you to skip part of the topic from compilation. Hence,

you can write comments inside COMMENT tags right in the place where they should be.

Batch Compile

Clicking on toolbar icons to get output is time-consuming when you need multiple formats at once. That's why
Helpinator allows you to create "batches" that consist of several "tasks". Each task allows to compile
selected output format with pre-selected language and variable preset and then save it to the specified
location.

Helpinator stores batches inside the project. 
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Batch Compile on the main Toolbar

When you click the drop-down arrow a list of batches saved to the project appears. You can click on a batch
in the list to run it instantly.

On-click execution of saved batches

When you click "Batch Compile" icon with a lightning bolt "Batch Compile" dialog appears. It allows to create
a batch by adding output tasks to it (double click on desirable output format in the list on the left), set output
destination path, language and variable preset.
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Batch Compile

Outputs are grouped by the purpose of the output format for convenience. To change extended settings of the
output double-click the format item in the task list or click "[Settings]" link in the "Settings" column. If the
output does not have extended settings then the cell in this column is empty.

MajorMindHelpViewer

MajorMindHelpViewer is a standalone context-sensitive help system viewer designed for use with help
outputs generated in Helpinator. It has the following modes:

1. MajorMindHelp - in this mode the viewer shows MajorMindHelp help system generated in Helpinator. You
can choose to show a local version or the one stored on an HTTP(S) server.

2. SimpleDocServer - in this mode you can specify an address of a SimpleDocServer server and show it's
content as a context-sensitive help.

3. Free-form HTML mode - allows to show any HTML-based output of Helpinator as a context-sensitive help
for your application. For example, you can make a context-sensitive help system out of topics published
to Wordpress.

You can use MajorMindHelpViewer to view HTML-based help systems that are published on your website.
There are two blog posts covering this:
WordPress for context-sensitive help
Knowledge Base for context-sensitive help
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Localizing help files

Helpinator allows you to create multi-lingual help projects. You can store all languages in one project file,
preserving project structure and topic context IDs across all supported languages. Thus you don't need to
manage separate help projects for all UI languages supported.

Helpinator localization capabilities stand on three whales:

1. Multiple languages in one project file
2. Language strings that allow to translate templates
3. XML Import/Export that allows to communicate with translation services and software.

Multiple languages

Additional languages in your project affect:
1. Topic titles and content
2. Project and topic keywords
3. Glossary
4. Text snippets

Important notice!

To compile CHM help files with locale different from your default system locale you might need
SbAppLocale.exe tool. Microsoft CHM compiler is not always capable of compiling correct CHM files with
other locales, for example it will fail to compile Cyrillic locales on US versions of Windows. 

The tool can be found here:

http://www.steelbytes.com/?mid=45

Download it and put into Helpinator installation folder.

To add languages to your project you can either use "Add languages" button in the "New Project" dialog or
"+" sign on the main tool bar next to the language drop-down list.

Add Languages

Language strings

Language strings allow you to translate common strings used in templates (like "Table of Contents" for
example) into desired language. To do it call "Main Menu->Tools->Options" and select "Language Strings"
tab. 
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Language Strings

XML Import/Export

XML Import/Export allows you to communicate with translation services and software. In general the
procedure is as follows:
1. Say you have a one-language project with "English" default language.
2. Add new language, for example "German" and check to copy default language to it.
3. Export XML using "Main Menu->File->Export XML". Select "German" language and folder to export files

to.
4. Helpinator will create a set of XML files with topics, keywords and glossary terms.
5. Send this files to your translation service or translate it with translation software.
6. Import translated XML back using "Main Menu->File->Import XML". Select "German" as destination

language and a folder where XML files are located.
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Quizzes

Quizzes in Helpinator are an easy way for your customers to check themselves for what they have learned
from your documentation. They are not intended to be used as a teacher control measure.

You can have as many Quizzes as you wish and embed them anywhere in the project, may it be the final
topic of the entire doc or chapter ends.

Each quiz question has:
1. Question text. You can format it as a regular topic, embed images, etc.
2. Answers. You can select answers numbering mode (letters or numbers), specify answers if they are not

given in the question text itself and mark correct answers (there may by more than one).

In case of HTML-based documentation quizzes are interactive and are shown as a form for user to fill. When
the user is ready he can click "Check answers" button and internal script will show a message with results
(OK or not OK). If not OK, the user should figure out what is wrong, there will be no clues.

In case of printable docs and HTML docs without scripts, quizzes are not interactive, showing only circles (for
single-choice answers) and boxes (in case of multipel choice answers) for a user to check with a pen.

You can check the sample quiz or look through a step-by-step guide on how to create and embed quizzes.

Quizzes Editor Overview

To activate Quiz Editor first select "Quizzes"  node in the project tree view. If it is not visible, then click
"Quizzes" button on the project tree filter toolbar:

Filter Quizzes in the tree
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Quizzes node

List of Quizzes looks like this:

Quiz list

Double click a quiz in the list and the Quiz Editor appears:
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Quiz Question Editor

Quiz Answers Editor
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How to Embed a Quiz

You need to use QUIZ pseudo tag to embed a quiz into a topic and QUIZANSWERS tag for correct quiz
answers (usually at the end of the printable doc). Of course you can place correct answers in HTML-based
documentation as well, but it ruins experience for your users.

Optionally you can use editor drop down list to select a QUIZ and insert the tag in the place of caret.

Insert a quiz into a topic

Embed Quiz Answers into a topic

Sample Quiz

 
What is Helpinator?
 
Do you know now what is Helpinator?
 
¡  1 Screenshot tool
¡  2 Text Editor
¡  3 Help Authoring Tool
 
Who is Helpinator for?
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Check one or more answers.
 
¡  1 Doctors
¡  2 Novel Writers
¡  3 Technical Writers
¡  4 Software Developers
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FAQ Lists

Helpinator allows you to create and embed Frequently Asked Questions (FAQ) lists. Of course you can
create FAQs with a regular topic editor, but it is not fully convenient and large FAQs are hard to manage this
way. Helpinator has a specialised editor for FAQs and also renders FAQs as collapsible sections in case of
HTML-compatible formats. See sample FAQ page for example or check out a step-by-step guide on how to
create FAQs using Helpinator.

You can add as many FAQ lists into your project as you wish. You may find it useful when you need to add
FAQs at the end of each large chapter of documentation.
Each FAQ contains of sections that help to organize questions in it. Questions belong to sections. Answer
text is like a regular topic, you can embed images, step-by-step guides or code snippets into FAQ answers. 

FAQ Editor Overview

To open up FAQ editor first select the FAQ node in the project tree view. If there is no "FAQ" node check out
the FAQs are not filtered out from project view, corresponding button on the leftmost toolbar should be
checked.

FAQ filter button

Helpinator 3.23 Manual

227



FAQs node

List of FAQs looks like this:

List of FAQs

Double click a FAQ and FAQ editor appears:
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FAQ Editor

Edit Questions
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How to Embed a FAQ

To embed a FAQ into a topic you need to use FAQ pseudo tag. You can enter it manually or place cursor into
a desired position and select a FAQ from toolbar drop down list of the topic editor.

How to embed a FAQ

Sample FAQ

 
About Helpinator
 
Q: Why the program is called Helpinator?
 
Good question! It was named in a homage to author's great-uncle who coincidentally was named Helpinator.
Just kidding. For no reason actually, other that awesomeness. 
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Quiz Answers

Answers for "Helpinator Concepts" quiz

1: 3
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2: 3, 4

Microsoft Compiled HTML Help is a Microsoft proprietary online help format. It was introduced as the
successor to Microsoft WinHelp with the release of Windows 98 and is still supported in Windows 7.

 
HyperText Markup Language (HTML) is the main markup language for web pages. HTML elements are the
basic building-blocks of webpages.

HTML is written in the form of HTML elements consisting of tags enclosed in angle brackets (like <html>),
within the web page content. HTML tags most commonly come in pairs like <h1> and </h1>, although some
tags, known as empty elements, are unpaired, for example <img>. The first tag in a pair is the start tag, the
second tag is the end tag (they are also called opening tags and closing tags). In between these tags web
designers can add text, tags, comments and other types of text-based content.
 
jQuery is a cross-browser JavaScript library designed to simplify the client-side scripting of HTML.[1] It was
released in January 2006 at BarCamp NYC by John Resig. Used by over 55% of the 10,000 most visited
websites, jQuery is the most popular JavaScript library in use today.[2][3]
 
Portable Document Format (PDF) is a file format used to represent documents in a manner independent of
application software, hardware, and operating systems.[2] Each PDF file encapsulates a complete
description of a fixed-layout flat document, including the text, fonts, graphics, and other information needed to
display it. In 1991, Adobe Systems co-founder John Warnock outlined a system called "Camelot"[3] that
evolved into PDF.
 
The Rich Text Format (often abbreviated RTF) is a proprietary[6][7][8] document file format with published
specification developed by Microsoft Corporation since 1987 for Microsoft products and for cross-platform
document interchange.[citation needed]

Most word processors are able to read and write some versions of RTF.[9] There are several different revisions
of RTF specification and portability of files will depend on what version of RTF is being used.[7][10] RTF
specifications are changed and published with major Microsoft Word and Office versions.
 
Web help is a type of online help that can either be delivered through the internet or as a stand-alone set of
HTML files on a computer. A well-known example of such a system is WebHelp.Com[1]. This approach,
mixing internet and local resources, is also used in Windows XP's Help and Support feature.
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